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www.myvisionexpress.com

Meaningful Use of Certified EHR Technology with My Vision Express

Eligible Professional Guidelines for Stage 1 of the Medicaid and Medicare EHR Incentive Programs

According to the provisions of the HITECH Act, eligible professionals (EPs) that participate in the Medicare ﬂ
and Medicaid programs can qualify for incentive payments if they adopt and successfully demonstrate INFO GA\RD
meaningful use of certified electronic health record (EHR) technology. My Vision Express Version 10.0 has )
been ONC-ATCB certified as a Complete EHR system for ambulatory practice settings (CMS EHR M
Certification ID: 30000001SVGLEAC).

For the Medicare and Medicaid incentive programs, EPs must comply with certain objectives in three stages. During
Stage 1, they must comply with 20 objectives: 15 from a “core set”, plus 5 that they must select from a “menu set” of 10
objectives. This document describes how to establish the required compliance with each objective using My Vision
Express.

Core Set of Objectives

EPs must comply with all of the following 15 objectives:

1. CPOE for Medication Orders

(0).][<ed\=H8 Use computerized provider order entry (CPOE) for medication orders directly entered by any licensed
healthcare professional who can enter orders into the medical record per state, local and professional
guidelines.

\ENIIZE More than 30 percent of all unique patients with at least one medication in their medication list seen by
the EP have at least one medication order entered using CPOE.

15 (d[VeJaB Any EP who writes fewer than 100 prescriptions during the EHR reporting period.

How to Comply Using MVE:
. . P y . . y .
In the patient profile or Exam screens, go to the ‘Health’tab and select the ‘Medications’ sub-tab to write your
medication prescriptions using the |e-Prescribe] button or the button (to access the Rx Pad).
8% Patient: Franklin, Benjamin(M) 'Ben’ 01/17/1916 (== =]
Patient rio: 4 Patiert name: Mr. Benjamin Franklin [ Search... ] [ Fisfresh ] [ Add ] [ Letters.. ]
Prafile | Demagraphics | |nsurance | Visiaon Ry | Files I Histary | Family | WSP Packing Slips | Health ‘ Custom Fields I Interactions |
| vitalSigns | Problem List | Allrgies | Mediations | Fanily History | Disclosues [ Immunizations | Laboratory | Disgnostic Tests | HL7 CCD/CCR |
Show. @ Active () Al Ma Known Medications
Rx Date |Category |Medication lSlrength | Dispense | Dosage number | Dosage Form Route Frequency |Du|ation Curation Type| F add
01/27/2011 | Systemic |TobraDex 030.1% 1 1/application in both eyes  |DAILY -
01,/25/2011 | Systemic |Singulair 10mg 10 1ltablet by mouth DAILY
- 06/23/2011 |Ocular
e Es) [ Deee |
@Ocia  © Sy
Location: MVE: My Vision Epecare [=] Physiciar: [Snellen, Heman MD [677] 8827456 (877 » | (][] Outside R
R date DE/Z3/72011 [ =] Espirg date: [(9/23/2071 [=] Discantinued [=] Ruikist
Medication group: Glaucoma [+] Medicatior: Betagan [=] Quantiy/Dispense: | Ten(1I0)ml [+ ] Refils: [Zem [+]
Dosage # 2 Dasage: |application [=] Applicatior: | eyes. bath [+] Frequency: [Q12H [+ Fax
Duration: Duration type: R=CUI: Stiength: 0.2% mg
[7] Dispense as witten [7] Beleased  Release date: [+] [7] Locked  Lack date: [+]
Source: [w] [7] Dispensed  Dispensed By [+]
Instructions:
14 »
Prirt ] l 0K ] l Cancel ]
| Kl i b
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2. Drug Interaction Checks

0s)[lad\7sH8 Implement drug-drug and drug-allergy interaction checks.

\VEEHVEE The EP has enabled this functionality for the entire EHR reporting period.

How to Comply Using MVE:

In the patient profile or Exam screens, go to the ‘Health’tab and select the Medications sub-tab to write your
medication prescriptions using the button. In the NewCrop website, you can specify drug-drug and
drug-allergy interactions for the patient. You can also see interactions created by other providers in the Surescripts
network. When you create a prescription, NewCrop will present you with a warning message if the drug that you are
prescribing triggers one of the interactions specified for the patient.

% hitps:/fsecure.newcropaccounts.com/Pages/ComposeRx.aspx# TopOfinProcessMeds

[E=8Ech =

Compose Page Drug Review

Allergy Drug
Betagan 0.5 % Eye Drops

m

Close
Only allergies and contraindicated / most severe interactions are shown. Moderate interactions appear on the Review Page.

3. Maintain Problem List

(0])<14{\7<H Maintain an up-to-date problem list of current and active diagnoses.

\I[EEUGGE More than 80 percent of all unique patients seen by the EP have at least one entry or an
indication that no problems are known for the patient recorded as structured data.

How to Comply Using MVE:

In the patient profile or Exam screens, go to the ‘Health’tab and select the ‘Problem List’ sub-tab. You can maintain

the problem list for the patient by adding, editing or deleting conditions. If no condition is specified, you can check the
‘No Known Problems’ checkbox.

1% Patient: Franklin, Benjamin(M) 'Ben’ 01/17/1916 ==

Patient no: 4 Patient name: Mr. Benjamin Franklin [ Search... ][ Refresh ][ Add ][ Letters... ]

| Profile | Demographics | Insurance I Wizion Fix | Files | Histaomy | Fanmily | WSP Packing Slips | Health | Custarn Fields | Interactions |

Yital Signz | Problemn List |Allergies | Medications I F amily History | Digclosures | Immunizations | Laboratary | Diagnostic Tests | HLY CEDACCR |

Show: @ Active ()41 Mo Enown Problems

| |Date of Onset |ICD Froblem Eye | Status

> [03/03/1960[ & | 401.0 Hypertenzion, M alignant Ma |Active
05/12/1974 & | 250 Diabetes Mellitus, dult MA |Active
0F/23/2000 - | 3674 Fresbyopia U |Active
0 /232005 | 3551 Glaucoma, Jpen Angle, Unspecified OU |Active Export HLT

ICD Code ...
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4. e-Prescribing (eRx)

(0).][Sai\/=H Generate and transmit permissible prescriptions electronically (eRx).

V=GR More than 40 percent of all permissible prescriptions written by the EP are transmitted
electronically using certified EHR technology.

([l [eJaB Any EP who writes fewer than 100 prescriptions during the EHR reporting period.

How to Comply Using MVE:

In the patient profile or Exam screens, go to the ‘Health’tab and select the Medications’ sub-tab to write your drug
prescription using the button. In the NewCrop website, you can transmit your prescription to the patient’s
pharmacy of choice.

p‘i https://secure.newcropaccounts.com/Pages/TransmitRx.aspx EI@

MY VISION EYECARE Pharm: 0 Fax: 47 Pend: 1 INSIGHT SOFTWARE LLC  °
Select Dr./Staif Compose Rx Med Entry Pt. Details Diagnoses Admin

MY VISION EYECARE Transmit Rx Designated Dr/Prescricer: H. Snellen

ratent: Benjamin Franklin oos: 1/17/1916 Gender: Male WellCare Dividend South Florida: FL =

Encounter ID: 1256

Rx(s) for transmission:

Rx Date Refill Doc [ Loc
Stage Source
06/23/11 Betagan 0.5 % Eye Drops 1 drop in both eyes daily 1 Milliliter 0 Snellen

InProc Days Supply: 7
Click here to specify mail-orderfhome-delivery for all the above Rx. Return to Route Rx to modify as needed.

Complete Mail Order Information and FAQs

| Transmit Rx/Add to Record |

Bogus Pharmacy Via: Electronic Fax: 4151111111 (required)
Phone: 111 Nowhere San Francisco, CA 399999
‘Herman Snellen I is not registered at ‘MY VISION EYECARE for the SureScripts network. Scripts will be faxed.

Pharmacy List Add Pharmacy

[ [Name  Address  Phone Jerx JFax |
111 Nowhere St
@ [CVS Pharmacy San Francisco, CA 99999 @ HM5111-111
" 112 Nowhere St
WELEEE San Francisco, CA 99999 @ 4151111112

@ this patient's previous pharmacies (change on Pt. Detail) @ available mail-order @ SureScripts\Retail electronic pharmacy

Py . Y sl

5. Active Medication List

(0] )[4 /)78 Maintain active medication list.

\CERIGE More than 80 percent of all unique patients seen by the EP have at least one entry (or an indication that
the patient is not currently prescribed any medication) recorded as structured data.

How to Comply Using MVE:

In the patient profile or Exam screens, go to the ‘Health’tab and select the ‘Medications’ sub-tab to see the list of
medications for the patient. By default, only the active medications will be displayed. If the patient has no medication
currently prescribed, you can tick the No Known Medications’ checkbox.

?“ Patient: Franklin, Benjamin(M) 'Ben’ 01/17/1916 o || = || &8
Patient no: 4 Patient name: |Mr. Benjamin Frankiin [ seach. | [ Refesh | [ add | [ Letters.
| Frafile | Diemographics I Ingurance | ‘Wigion Rx | Filez | Histom | Fannily |VSF' Packing Slips | Health | Cugtom Figlds | Interactions |

| Wital Signs | Problem List I Allergies| Medications | Farnily Hiztary | Dizclozures | Imrunizations | Labarataon | Diagnostic: Tests | HL? CCD/CCR |

S haow: @) Active 2l Ma Enown Medications
Fx Date  |Category |Medication |Strength | Dispense | Dosage number | Dosage Form Route Frequency |Du|ation Duration Type| F o
01/27/2011 |Systemic |TobraDex 0.301% 1 1/application in both eyes | DAILY

01/25/2011 | Systemic |Singulair 10mg 10 1|tablet by mouth DAILY Madify
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6. Medication Allergy List

(0)][Sad\/=H Maintain active medication allergy list.

\[ERUIGGE More than 80 percent of all unique patients seen by the EP have at least one entry (or an

How to Comply Using MVE:

In the patient profile or Exam screens, go to the ‘Health’ tab and select the ‘Allergies’ sub-tab. Medication allergies are
marked in the ‘Allergy Type’column as “Drug”.

indication that the patient has no known medication allergies) recorded as structured data.

-

Fatient no:

r’i Patient: Franklin, Benjamin(M) ‘Ben' 01/17/1916

4 Patient name: Mr. Benjamin Franklin | Search... | | Refresh

| Prafile | Demographics | Inzurance | Wigioh Fx | Filez | Histary | F arnily |VSF' Packing Slips | Health | Custarn Fields | Interactions |

| Wital Signe | Froblem List| Allergies | Medications | Family Higtomy | Dizclozures | |mmunizations | Laboratom | Diagnostic Tests | HL? CCDACCR |

Shiow: @) Active All Mo Known gllergies
Date Created  \Allergy Tepe l&llergy Reaction Statug Date Modified | Source | Add
06/24,/ 2011 El Dirug Acetaminophen Active Q0000000 El ER= W
06/24,/ 2011 El Dirug Betagan Active Q0000000 El ER=

e-Frezciibe

7. Record Demographics M

Objective:

Record all of the following demographics: preferred language, gender, race, ethnicity and date of birth

Measure:

More than 50 percent of all unique patients seen by the EP have demographics recorded as
structured data.

How to Comply Using MVE:
In the Profile’ tab of the patient profile screen, you can record the required demographics information for each patient.

Motes:

Balance

w € Patient: Franklin, Benjamin{M) 'Ben’ 01/17/1916 =n (==
Patient no: 4 Patient name: Mr. Benjamin Franklin | Search... | | Refresh | | Add | | Letters... |
Profile | Demographics | Insurance | Wision R | Filez | History | Farnily | WSP Packing Slips | Health | Custom Fields | Interactions |
Title: mlzl First: Benjamin tiddle: Last: Franklin Suffis: Mickname: Ben V| Active
ticldress line 1: (318 Market St ® Primary Biling Shipping Location: MYE: My Vision Eyecare Labels...
Address line 2: Bad address v IHIFEECaRsent] Consent Date: [12/22/2010 [+ ] " Delte
Ciby: Fhiladelphia State: Pa Zip: 19108 Country: Ref:

Home phone:  [215) 965-2305 Mobile: [ 1 - “Work phone: [800) 275-8777 Eut: Akl 1 - Fam [ ] -

Birth date: 01171916 E| Age: 95ybm Sex: [Male SSM: 987654321 Email: beni@iusps. com [7] Pref. contact: E-mail V| Send mail
b arital status: wWidowed Ethnicity: Mot Hizpanic or Latino | Race: MWhite Smoking tatus: former smoker

Language:  [Endglish Employment; |Employed Fulltime Dceupation: Postmaster General | Hobbies: Stom chasing |:|

Provider: Dr. Hermat Shellen MD Last ewam: (1241672070 Recall reason: Annual Exam (12 m Months: 12 Exam Recall. 1241642011

Entered: 12416/2010 El Type: Spectacle Recall reason; B manths Months: B Followup Recall 08A16/2011 El

Alert:

Guardian: Relationship: Phore: [ 1 - EFRESCRIBE

Emergency;  |Sarah Franklin Felationzhip: Child Phone: [215] 365-2305 Altphone: [ ] -

Frimary Physician: Phore: [ 1 - | ePresciibe

Patient balance: 877,98
Insurance balance: 479.00
Total balance: 1356.98

Last Order Diagnosis

3. - - 4
Scan Scanner...

Dialog

Order Mo 168 Order date: 04/23/2011 Order type: Spectacls Leng

Code 1: 3671 Code 2 367.2 Code 3: 367.4 Code 4
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8. Record Vital Signs

(0).][ai\7<8 Record and chart changes in the following vital signs: height, weight and blood pressure. Calculate and
display body mass index (BMI). Plot and display growth charts for children 2-20 years, including BMI.

\CEREIGGHE For more than 50 percent of all unique patients age 2 and over seen by the EP, height, weight, and
blood pressure are recorded as structured data.

S ([I[eJsB8 Any EP who either sees no patients 2 years or older, or who believes that all three vital signs of height,
weight, and blood pressure of their patients have no relevance to their scope of practice.

How to Comply Using MVE:

In the patient profile or Exam screens, go to the ‘Health’tab and select the *Vital Signs’ sub-tab. You can record blood
pressure readings here along with the height and weight measurements. BMI is automatically calculated based on
height and weight. Click the button to display the required data plots.

"‘ Patient: Liddell, Alice(F) 05/04,,1990 EI@

Patient na: 115 Patient name: Ms. Alice Liddell [ seach. | [ Refiesh | [ add | [ Letters. |

| Prafile: | Demographics | Insurance IVision Fix I Files | Histary | Family |VSF' Packing Slips | Health |Eust0m Fields | Interactions |

Yital Sigrns | Problem List | Allergies | Medications | Fannily Hiztory | Dizclosures | Imrunizations | Laboratary | Diagnostic Tests | HL? CCD/CCR |

Created Date Age Nrs]lBIood Pressure [Systolic] Blood Pressure [Diastolic] |Arm Pulze Height [ft]l Height [Inches]lWeight [Ibz] BMI| add
014201936 E| g 3 3 25.0 11.6
01191957 [+] 7 4 I 90.0 18.2
014181938 E| g 5 E 120.0 19.4
014171939 E| 9 120 a0Left 25 [ 0 135.0 18.3
0116/2000  [+] 10 125 FOLeft a0 [ E 133.0 16.1
2> |1 /17/200 El 1 18 Groowth Chr: Alce Licdal (Famale) Agqe: 21 =
Chat Typs: “whaigh. o, - i e, 1 bor iy
DABR00Z  [w] 12 == ‘
01/15/2003 |+ 13 Height for Age (Female)
01/14/2004 E| 14 150+ [
DA [w] 15 :
|
|
|

Height (in}
=

%]
[=]

nH =h Y m B o % T * owmh " oemh T Ak Y pwan

9. Record Smoking Status

Objective: ‘ Record smoking status for patients 13 years old or older.

\EEHUEE More than 50 percent of all unique patients 13 years or older seen by the EP have
smoking status recorded as structured data.

Exclusion: ‘ Any EP who sees no patients 13 years or older.

How to Comply Using MVE:
In the ‘Profile’ tab of the patient profile screen, record the ‘Smoking status’ for patients.
¢ Patient: Franklin, Benjamin(M) 'Ben’ 01/17/1916 [=
Patient no: 4 Patient name: Mr. Benjamin Franklin [ Search.. ] [ Refresh ] [ Add ] [ Letla
Profile | Demographics | Insurance Vigion Fix | Filez | Hiztomny | Family | W5SP Packing Slips | Health | Cugtom Fields | Interactions ‘
Title: El First: Benjamin Middle: Last: Franklin Suffis: Mickname: Ben Btive
Address line 1: | 318 Market St @ Primary ) Billing ~ Shipping Location: MYE: My Vision Eyecare [ Lab: 1
Address line 2: [[] Bad address HIPA& Cansent| Consent Date: [12/22/2010 El DE;
City: Philade/phia State: P4 Zip: 19106 Counitry: Ref:
Home phone:  [215] 965-2305 Mobile: [ 1 - “whork, phone: [B00) 275-8777 Ext: Akl 1 - Fax [ 1 -
Birth date: 0171916 El Age: 95p5m Sex: Male S5M: 987-65-4321 Email: ben@usps. com Pref. contact: E-mail Send mai 3
Marital status: Widowed Ethnicity: Mat Hizpanic or Latine | Race: white Smaking status: |[former smaker
i [ ] -~ "
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10. Clinical Quality Measures [CQMs)

Objective: ‘ Report ambulatory clinical quality measures to CMS.

\[ERTIGE Successfully report to CMS ambulatory clinical quality measures selected by CMS in the manner
specified by CMS.

How to Comply Using MVE:
Go to Reports > Patients > Clinical Quality Measures to generate the required report.

Clinical Quality Measures Report

Core Clinical Quality Measures
NQF 0421 :: Title: Adult Weight Screening and Follow-Up

Description: Percentage of patients aged 18 years and older with a calculated BMI in the past six
months or during the current visit documented in the medical record AND if the most recent BMI is
outside parameters, a follow-up plan is documented.

Denominator: 5
Age >= 65 Percentage: gg ¢,
Numerator: 4

Age >= 18 Denominator: 10

Percentage: 40 v,
and < 65 Numerator: 4 9 &

NQF 0013 :: Title: Hypertension: Blood Pressure Measurement

Description: Percentage of patient visits for patients aged 18 years and older with a diagnosis of
hypertension who have been seen for at least 2 office visits, with blood pressure (BP) recorded.

NMWMMMW

11. Clinical Decision Support Rules

(0].)[<l4/\=88 Implement one clinical decision support rule relevant to specialty or high clinical priority along with the
ability to track compliance with that rule.

Measure: ‘ Implement one clinical decision support rule.

How to Comply Using MVE:

Go to the Patient Alerts window (File > Setup > Exam > Alerts) and click the button to specify new alerts. You will get
the Message’ that you specify in a warning dialog if you prescribe the medications targeted by an alert and the patient’s
lab results, age, ethnicity and race match the criteria that you specify on that alert.
@Pat\entmerts E@ @Pat\antAlert;Details

Problem | Medication I Laboratory Test Results

[ICD Code [Problem Description
Cardiovascular Disease

Description Message  |Operator Age [Ethnicity Race Add
> 18] .

\L/ @ Patient Alerts Details
| Problem ‘MEdlCﬁtlUn Laboratory Test Results ‘

I edication [
Betagan
o

Alert

-
@ Patient Alerts Details

4
4 LI} r Problem | Medication | Laboratory Test Results |
Test Operator| Yalue |Unit ‘
Chalest SerPl-mChe > 200 | masdl
Description: Alert HDLc SerPlmCne < 40| mgddl
Message:  High cardiovascular risk! LDLe SerPHmCrc > 100 | mgsdl
Trigl SerPl-mCnc > 150 | mgsdl
Age: E] Ethricity Race: L
pr—
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12. Electronic Copy of Health Information

(0).][<ai\/<H88 Provide patients with an electronic copy of their health information (including diagnostic test results,
problem list, medication lists, medication allergies) upon request.

\[EEIGE More than 50 percent of all patients who request an electronic copy of their health information are
provided it within 3 business days.

S [I[eJsB8 Any EP that has no requests from patients or their agents for an electronic copy of patient health
information during the EHR reporting period.

How to Comply Using MVE:

In the patient profile or exam screens, go to the Health’tab and select the ‘HL7 CCD/CCR’ sub-tab. You can export an
XML file with the patient’s data in CCD format and provide it to the patient in any type of electronic media.

-

;" Patient: Wright, Oliver(M) 05/19/1984

Patient no: 2 Patient name: Mr. Oliver ‘Wright [ Search... ][ Refresh ]

Add

| Profile | Demographics | Insurance | “Wizian Rx | Filez | Histary | Farnily | W5P Packing Slips | Health | Cusztom Fields | Interactions |

| Yital Signs | Problem List | Allergies | Medications | Family History | Disclosures | Immunizations | Laboratony | Diagnostic Tests| HLy CED/CCR |

Filz Tupe | File: D | Created D ate Created By Last Updated Audit 1D Direction Sent to Healthvault | Exam |D |
2 CCD 127 BA2RS2MT 10727 |Ewpress, Vision BAZRS201T 101727 In a0
CCh 128 6/20/2011 12:24:33  |Express, Vision BA20/2017 122821 Out BA20/2011 122820 |0 -
Expoart
CCh 123 6/24/2017115:0310  |Express, Vision 6/24/2011 150310 In 0

Email

Delete

Wiew

13. Clinical Summaries

(0].)[47\7sH8 Provide clinical summaries for patients for each office visit.

\EEREGGE Clinical summaries provided to patients for more than 50 percent of all office visits within 3 business
days.

Exclusion: ‘ Any EP who has no office visits during the EHR reporting period.

How to Comply Using MVE:
In the patient profile or Exam screens, go to the ‘Health’ tab and select the ‘HL7 CCD/CCR’ sub-tab. You can click the
button to generate a Continuity of Care Document that you can provide to the patient.
”‘ Patient: Wright, Oliver(M) 05/19,/1984
Patient na: 2 Patient name: Mr. Oliver \Wright [ Search... ] [ Refresh ] [ Add
| Prafile | Demographics | Insurance |Viswon Fix | Files | Histary | Farnily |VSP Packing Slips | Health |Custom Fields | Interactions ‘
‘ ‘ital Signs | Prablerm List | Allergies | Medications | Farmily Histary | Dizclosures | Immunizations | Laboratary | Diagnostic Tests| HL? CCD/CCR |
File Type | File |0 | Created Date Created By Last Updated Audit 10 Direction Sent to Healthyault | Exam I ‘
3o 1z 5/26/2011 10:17:27  |Evpress, Vision 5/26/2011 10:17:27 In 0 i
CCo 128 6/20/2011 122433 |Ewpress, Vision 6/20/2011 12:28:21 Out 6/20/2011 12:28:20 [0 e .
oco 129 6/24/2011 150310 |Express, Vision £/24/2011 15:03:10 In 0 !
Coe )]
e 1§
3
L) o — N - B Jp———
NOTE: To be able to generate CCD files, you need to enter an ISO Object Identifier (OID) for your organization in MVE. For additional information on
how to obtain an OID and enter it in MVE, please check: http://support.myvisionexpress.com/index.php?/Knowledgebase/Article/View/120.
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14. Electronic Exchange of Clinical Information

(0).][Sai\/<88 Capability to exchange key clinical information (for example, problem list, medication list, medication
allergies, and diagnostic test results), among providers of care and patient authorized entities
electronically.

\EHV A Performed at least one test of certified EHR technology’s capacity to electronically exchange key
clinical information.

How to Comply Using MVE:

In the patient profile or Exam screens, go to the ‘Health’tab and select the HL7 CCD/CCR’ sub-tab. You can export an
XML file with the patient’s data in HL7 CCD format and forward it to another provider electronically. If another provider
sends you an HL7 CCD file electronically, you can use the button to load the information in that file.

'«11 Patient: Wright, Oliver(M) 05/19/1984
Patient no: 2 Patient name: Mr. Dliver Wright I Search... I I Refresh I I Add I

| Profile | Demographics | Insurance | Wigion Fs | Filez I History | F amily | W5P Packing Slipz | Health | Custom Fields | Interactions |

| Wital Signs | Problem List | Allergies | Medications | Family History | Disclosures I Immunizations | Labaoratory | Diagnostic Tests| HL7 CCD/CCR |

File Tupe | File: 1D | Created Date Created By Last Updated Audit 1D Direction Sent to Healthivault | Exam D |
3 CCD 127 BA26/20M110:17:27  |Express, Vision 5/26/2011 101727 In 0
CCD 128 6/20/201112:24:33  |Express, Vision E/20/2011 12:28:21 Out E/20/201112:28:20 |0 B
CCD 129 6/24/2011 150310 |Express, Vision E/24/2011 15:03:10 In 0 —
Dielete

Wiew
Email

Uplaad

L Jra— Y 2 - " RN

NOTE: To be able to generate CCD files, you need to enter an ISO Object Identifier (OID) for your organization in MVE. For additional information on
how to obtain an OID and enter it in MVE, please check: http://support.myvisionexpress.com/index.php?/Knowledgebase/Article/View/120.

15. Protect Electronic Health Information

(o))<l /\=48 Protect electronic health information created or maintained by the certified EHR technology through the
implementation of appropriate technical capabilities.

\EHIIES Conduct or review a security risk analysis in accordance with the requirements under 45 CFR
164.308(a)(1) and implement security updates as necessary and correct identified security deficiencies
as part of its risk management process.

How to Comply Using MVE:

Setup individual employee profiles for every user in the system (File > Setup > Employees) and assign each employee to
a security group. Specify the level of access for each security group from the ‘Security’ tab of the Company
Information screen (File > Setup > Company Information). Also, from this ‘Security’ tab, adjust the ‘Automatic log-off from
MVE’ value (this defines the period of inactivity after which the system will log users off automatically).

Use the Encryption/Hash Tool (Tool > Encryption/Hash Tool...) dialog to generate hash values to authenticate data files
that you exchange electronically and contain patient’s protected health information (PHI). Use this dialog to encrypt
these data files (before transmitting them electronically) also.

p’i Encryption/Hash Tool @

Browse C:4J sershddministrator\Desktoptuwright. xml

Functions

@ Generate Hash _) Validate Hazh ) Enciypt ) Decrypt
Generated Hask, 49938 3FBFFE331BEBCEY 2BAEE 3FF176B8E31 DEBA pr

Close

© 2011 Insight Software, LLC Page 8 of 15


http://support.myvisionexpress.com/index.php?/Knowledgebase/Article/View/120

Menu Set of Objectives

EPs must comply with 5 of the 10 menu set objectives outlined in this section. Of these five objectives, one

must be either objective number 9 (Immunization Registries Data Submission) or number 10 (Syndromic
Surveillance Data Submission); unless exceptions to both are obtained.

1. Drug Formulary Checks

(0147 Implement drug formulary checks.

\[EHTE The EP has enabled this functionality and has access to at least one internal or external formulary for

the entire EHR reporting period.

Exclusion: ‘ Any EP who writes fewer than 100 prescriptions during the EHR reporting period.
How to Comply Using MVE:

In the patient profile or Exam screens, go to the ‘Health’tab and select the Medications’ sub-tab to write your drug
prescription using the button. In the NewCrop website, you can select a plan and click the
Formulary: Preferred link to see the list of therapeutic alternatives in the patient’s plan.

¥ https://secure.newcropaccounts.com/Pages/composenc.aspx

@]z
MY VISION EYECARE Pharm: 0 Fax: 47 Pend: 2 INSIGHT SOFTWARE LLC
Select Dr./5taff Compose Rx Med Entry Pt. Details Diagnoses Admin
MY VISIOM EYECARE/Resources Compose Rx Designated DriPrescrier: H. Snellen

patient: Benjamin Franklin cos: 1171916 cencer: Male Select the patient's AARP Med Complete Plan 1: FL =
Encounter ID: 1259 insurance plan. I

Pending Rx Take Complete Rx to Review Page Adjust Disp# only after completing Sig.
Betagan 0.25 % Eye Drops

3 Formulary Breferred Dosing
Dose checking not performed
drop ~ eyes, both - #

I - [Select Frequency P day Click on the Formulary link

12 il ] e lchrcrked 10 day to see preferred

13 S DALY 14 day therapeutic aternatives.

2 =l 21 day

14# hitps://secure.newcropaccounts.com/Pages/Formularylnfo.aspgifiugld=22 =18:fid=3567&ftid=S =R R

Alternatives for Betagan 0.25 % Eye Drops

Therapeutic Alternatives

l Formulary Status

Betagan 0.25 % Eye Drops (Preferred

b Preferred

Betagan 0.5 % Eye Drops (Preferred Preferred
lol 0.5 % Eve Drops (Preferred) Preferred

bi lol 10 mg Tab (Preferred _‘F:sferred

2. Clinical Lab Test Results

(0])[<4 /)78 Incorporate clinical lab test results into EHR as structured data.
Measure:

More than 40 percent of all clinical lab test results ordered by the EP during the EHR reporting period

whose results are either in a positive/negative or numerical format are incorporated in certified EHR
technology as structured data.

Exclusion:

An EP who orders no lab tests whose results are either in a positive/negative or numeric format during
the EHR reporting period.

How to Comply Using MVE:

In the patient profile or Exam screens, go to the ‘Health’tab and select the Laboratory’ sub-tab to enter the parameters
for patient labs and record or view the results.

144 Patient: Darwin, Charles(M) 01/01/1900
Patient no: 1 Patient name: Mr. Charles Darwin [ seach. | [ Fetesh | [ aw |
Profie | Demomaphics | Inswance | VisanRs [ Fles [Histow [ Famiy [ VSP PackingSliss | Health | Custom Fields | Interactionss |
\ Wital Signs | Problem List | Allergies | Medications | Famnily History | Disclosures | Immnunizations | Laboratory \ Diagrostic Tests | HL7 CCO/CCR \
Resuls |
Show resuls for order only:
Order 1D [Test Typs [ LOING Test Name Test Fieport Date Normal ange [Fesult Valus Uit Measurs|Test Low Add
> [T < B acic Metabolic Panel |23415 Blood Glucoss: 1271672003 | <6099 g/l
11 B.asic Metabolic Parel | 178615 Caisium 121572008 |« |8.3104 3 mg/dL
12 [Basic Metabolic Panel |2051-2 Sodum 12A16/2009 | |135-144 Tabmmol/L
13 [Basic Metabolic Parel | 227603 Fotassium 12/16/2009 | ]3.755 A BmmoliL
14 [Basic Metabolic Panel |20289 Carbon Diowide 12A16/2003 | 2031 2ol LOINC..
L 15 Sesic Malabole Bonel o ial, Ch nﬁ 124152000 29110 BT
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3. Patient Lists

(0).][ai\/<8 Generate lists of patients by specific conditions to use for quality improvement, reduction of disparities,
research, or outreach.

\CETIH Generate at least one report listing patients of the EP with a specific condition.

How to Comply Using MVE:

The button in the ‘Search’ tab of the Letters screen can be used to search for patients with any given
combination of medical problems, medications, lab results, allergies and immunizations.

@ Patient Extended Search @
Probleml Medication | Laboratory Test Results | Allergies | Immunizations ‘
Operator | Problem ICD Code |ICD |Duralian Duration Type |Status |ANDJDF|
= |Glaucoma - Absalute 360.42 [ Active AMD
@ Patient Extended Search @
‘ Problem | Medication §| Laboratory Test Results | Allergies | Immunizations
Operator |Medication buralinn Duration Type |Status AND/OR
= Betoptic Active AND
L P i,
@ Patient Extended Search @

‘ Problem | Medicatio | Lillergies | Immunizations ‘

Walue | Unit Measure [ AND/OR |

Test
HDLe SerPl-mCne > 200 Mag/dl AND
@ Patient Extended Search @
‘ Problerm | Medication | Laboratory Test Results |A\|Blglas| Immunizations ‘
Operator Allergy Status AND/OR |
= |Mortiptyline Active
@ Patient Extended Search @
‘ Problem | Medication | Laboratory Test Results | Allergies ||I'ﬂmum2allons |
Operator| Admin. Code: Admin. Cade Description |AND#’DF\|
= B0 herpes simplex vius, type 2 vaccine

4. Patient Reminders

(0].)[=l¢/\=4 Send reminders to patients per patient preference for preventive/follow-up care.

\EHIIEE More than 20 percent of all patients 65 years or older or 5 years old or younger were sent an
appropriate reminder during the EHR reporting period.

13 (d['e]gB8 An EP who has no patients 65 years old or older or 5 years old or younger with records maintained
using certified EHR technology.

How to Comply Using MVE:

Specify the recall dates in the ‘Assessment’tab of the Exam screen or directly in the patient profile screen. Go to
File > Letters to generate your recall letters periodically.

"’ Patient: Franklin, Benjamin(M) 'Ben’ 01/17/1916

Fatient no: 4 Fatient name; Mr. Benjamin Franklin [E |
Profile |Demugraph\cs I Insurance Vizion Rx I Files I Histomy | Family IVSF Packing Slips | Health | Custom Fields I Interactions ‘

Title: QImE=]  First: Beniamin Middle: Last: [Franklin S Mickname: Ben

Address line 1; 318 Market 5t @ Primary ~) Billing _) Shipping Location: MYE: My ¥ision Eyecad
Address line 2 [] Bad address HIFEEICEREERE] Consent Date: 12/22/2010
City: Philadelphia State; Pa Zipe 19106 Country: Ret
Home phone:  [215) 965-2305 Mohils: [ ] - “whork phone: [800) 275-8777 Ext: Akl 1 - Fax [ ]
Birth date: 01171918 Iz‘ Age: 95y5m Sex: Male S5M: |387-65-4321 Email: ben@usps.com E] Pref. contact: E-mail
Marital status: Widowed Ethnicity: Mot Hizpanic o Lating | Race: white Smoking status: former smoker
Language: English Employment. Employed Fulltime Occupation: Postmaster General Hobbies: |Storm chasing D
Provider: Dr. Herman Snellen MD Last ewam: [12/16/2010 El Recal reason: dnnual Exam (12 ) Months: 12 Exam Recal:  [12/16/2011 El
Entered: 12162010 ] Type [Spectacle Recall reason: & months Months: 8 Fallowun Recal D6A16/2011 [+]
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5. Patient Electronic Access

(0).][ai\/<88 Provide patients with timely electronic access to their health information (including lab results, problem
list, medication lists, and allergies) within 4 business days of the information being available to the EP.

\CERIIGH At least 10 percent of all unique patients seen by the EP are provided timely (available to the patient
within four business days of being updated in the certified EHR technology) electronic access to their
health information subject to the EP’s discretion to withhold certain information.

S ([I[eJsi8 Any EP that neither orders nor creates lab tests or information that would be contained in the problem
list, medication list, medication allergy list (or other information as listed at 45 CFR 170.304(g)) during
the EHR reporting period.

How to Comply Using MVE:

My Vision Express has created a web portal called My Vision Chart that integrates with Microsoft HealthVault. You can
upload patient records to this portal and then each patient can update his HealthVault account based on the information
that you provide. Your practice will need to register with My Vision Chart and HealthVault before you can start
uploading patient records.

Patients will also need to register with My Vision Chart to port their records to HealthVault. My Vision Express
generates a link and PIN code that you will provide to them so that they can complete this registration process.

] g\ Microsoft:
Connects with HeaIthVauIt”

6. Patient-specific Education Resources

(0].)[<lqi\=H Use certified EHR technology to identify patient-specific education resources and provide those
resources to the patient if appropriate.

\EEHIIEES More than 10 percent of all unique patients seen by the EP are provided patient specific education
resources.

How to Comply Using MVE:

In the Education Resources screen (File > Setup > Education Resources), click the Add button to specify a new education
resource. From the ‘Assessment’ tab of the Exam screen, click on the button to see a list of education
resources to be presented to the patient. In the ‘Health’ tab —under the ‘Problem List’, ‘Medications’ or ‘Laboratory’ sub-
tabs— select a record and click the button to display the education resource relevant to that record.

& Patient: Darwin, Charles(M) 01/01/1900

Patisnt no: 1 Patient name: Mr. Charles D anwin [ Seaich... ][ Relresh ][ Add ] .

Pratile |Demographu:s I\nsulance |\u’\s\oon |F|Ies |H|slo|y IFamlIy IVSFPackmgShps |Heallh |EustomF|e\ds |\nteracl\ons |

Wital Signs | Prablem List | Allelgles| Medications ‘ Disclosures | Immunlzatlunsl Laboratary | Diagnostic Testsl Family History | HLa? CCD/CCR |

Show. @ Active (Al Mo Known Medications

RxDate | Expiy Date | Discontinued |RxCUI [ Medication Strength | Dispense | Refills | Dosage number | Dosz [ Add
2 [01/31/201]04/30/201 =] 00/00/000( 1206312 Betagan Ten (10) ml 0 1ldrop W

[ Delte |
RxPad..
E=
Cems |

& Patient Education

un Selected)

Selection| Education Name File Link
*| [¥] |Betagan Diug Information C:\Users\administrator\Downlosds\betagan_pi pof

Education Provided

= BETAGAN® Prescribing Information - Adobe Reader

File Edit View Document Tools Window Help x
B € % 2/ @@ ux- o @ A -

INDICATIONS AND USAGE
BETAGAN® ophthalmic solution has been shown to be effective in lowering infraocular
pressure and may be used in patients with chronic open-angle glaucoma or ocular hypertension
CONTRAINDICATIONS

BETAGAN" ophthalmic solution is contraindicated in those individuals with bronchial asthma,
or with a history of bronchial asthma. or severe chronic obstructive pulmonary disease (see
WARNINGS): sinus bradycardia; second and third degree atrioventricular block: overt cardiac
failure (see WARNINGS); cardiogenic shock; or hypersensitivity to any component of these
products. P

WARNINGS

As with other topically applied cphthalmic drugs. BETAGAN® may be absorbed systemically
The same adverse reactions found with systemic administration of beta-adrenergic blocking
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7. Medication Reconciliation

Objective:

The EP who receives a patient from another setting of care or provider of care or believes an encounter
is relevant should perform medication reconciliation

Measure:
patient is transitioned into the care of the EP.

The EP performs medication reconciliation for more than 50 percent of transitions of care in which the

Exclusion:

An EP who was not the recipient of any transitions of care during the EHR reporting period.

How to Comply Using MVE:

the Drug Review link to generate a report.

In the patient profile or Exam screens, go to the ‘Health’tab and select the ‘Medications’ sub-tab. Use the
button to access the NewCrop website. Review the list of Current Medications at the bottom of the page and click on

City State Zip Miami, 33186

Day/Work
Phone
Evening/Home
hone

Address: Day Phone:

5555655565

Mouse
Harrah
Harrah

Betagan 0.5 % Eye Drops
Singulair 10 mg Tab
tobramycin 0.3 % Eye Drops

Address Information

Address 13880 SW 103rd Ln

Contact Information

Evening Phone::

Reviews performed: Drug-Drug: 0 found Drug-Allergy: 0 found Drug-Disease: 0 found

Current Medications:

Doctor _IMedication ________________[Directions _____ ]
1 drop in both eyes daily

1 tablet by mouth daily

1 drop in both eyes daily

¢ https://secure.newcrapaccounts.comy/Pages/PatientMedicationReview.aspx e = =)
MY VISION EYECARE Pharm: 0 Fax: 47 Pend: 2 INSIGHT SOFTWARE LLC ~ *
Select Dr./Staff Compose Rx Med Entry Pt. Details Diagnoses Admin
Designated Dr/Prescriber: H. Snellen
ratient: Charles R Darwin pos: 1/1/1900 cenger: Male SelectHealth HMO: UT -
Encounter ID: 1260
Close
PatientCharles R Darwin
MRN/Chart# 1
DOB 01/01/1900
Gender Male

m

8. Transition of Care Summary

Objective:

The EP who transitions their patient to another setting of care or provider of care or refers their patient
to another provider of care should provide summary care record for each transition of care or referral.

Measure:

The EP who transitions or refers their patient to another setting of care or provider of care provides a
summary of care record for more than 50 percent of transitions of care and referrals.

Exclusion:

the EHR reporting period.

An EP who neither transfers a patient to another setting nor refers a patient to another provider during

How to Comply Using MVE:

In the patient profile or Exam screens, go to the Health’ tab and select the ‘HL7 CCD/CCR’ sub-tab. You can export an
XML file with the patient’s data in HL7 CCD format and forward it to another provider.

w4 Patient: Wright, Oliver(M) 05/19/1984

Fatient no: 2 Patient name: Mr. Qliver wright

E

{ Seaich.. I{ Refresh Il

)

| Profie | Demographics | Insuance [ VisinPx | Fies | Histoy | Famiy | V3P Packing Slins

| Health | Custom Fields | Interactions |

Vitel Signs | Problem List | Alleries | Medications | Famiy History | Disclasures [ Immunizations | Laboratory | Diagnostic Tests| HL? CCD/CCR |

File Twpe | FilelD | Created Date Created By Last Updated

= CCD 127
CCo 128
CCD 129

5/26/2011 10:17:27
B/20/2011 12:24:33
6/24/2011 15:03:10

5/26/2011 10.17.27
B/20/2011 12:28:21
6/24/2011 15:03:10

Express, Vision
Express, Vision

Express, Vision

it 1D ; Direction | Sent to Healthault \UExam\D [ i
o]

Out £/20/201112:2820 |0
In 0

© 2011 Insight Software, LLC
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9. Immunization Registries Data Submission*

10].)[-la)"/-H8 Capability to submit electronic data to immunization registries or immunization information systems and
actual submission according to applicable law and practice.

\EERUGE Performed at least one test of certified EHR technology’s capacity to submit electronic data to
immunization registries and follow up submission if the test is successful (unless none of the
immunization registries to which the EP submits such information has the capacity to receive the
information electronically).

S (d[I[eJaB8 An EP who administers no immunizations during the EHR reporting period or where no immunization
registry has the capacity to receive the information electronically.

How to Comply Using MVE:
In the patient profile or Exam screens, go to the ‘Health’tab and select the immunizations’ sub-tab. You can an
XML file with the patient’s immunization data in HL7 format. Follow up with your state’s immunization registry for
instructions on how to upload immunization files.
( w# Patient: Darwin, Charles(M) 01/01/1900 ===

Patient no: 1 Patient name: Mr. Charles Darwin [ Search... ][ Refresh ][ Add ][ Letters... ]

| Prafile | Demographics | Insurance IVision R I Filez I Histary | Family | WSP Packing Slips | Health | Custom Fields | Interactions |
| Laboratary | Diagnostic Tests | HL? CCD/CCR |

Administration | Administration |Admin. Codel\laccine Mame Administered Administered | Substance Lot | Substance|Susbstance fdd
Start End Amount Units Code MHumbers Code  |Manufacture
2 02A55201 E| 02584201 1E| 11 |influenza virus vaccine, live, attenuate SmL 49281-37215  |PMC zanofi pastel

10. Syndromic Surveillance Data Submission*

(0].)[=lq /)= Capability to submit electronic syndromic surveillance data to public health agencies and actual
submission according to applicable law and practice.

\EHVEE Performed at least one test of certified EHR technology’s capacity to provide electronic syndromic
surveillance data to public health agencies and follow-up submission if the test is successful (unless
none of the public health agencies to which an EP submits such information has the capacity to receive

the information electronically).

S @['HJgi An EP who does not collect any reportable syndromic information on their patients during the EHR
reporting period or does not submit such information to any public health agency that has the capacity
to receive the information electronically.

How to Comply Using MVE:

Go to File > Reports > Patient > Syndrome Surveillance. In the ‘Criteria’ tab, after specifying the range of dates and the
ICD Code to search for, click the button. In the Preview’tab, click the button to save the data in the
required HL7 format for CDC submission.

'i Reports - Syndrome Surveillance EI@
Preview
led Cod [Prablem N Date Resalved First M LastM Last Exam Dat |
4CI:J1.D0 - Hrpe.ret:nsizr:,el\"lalignant S Bl;iianji:e F:nkli:me 1;,-8-'1 Bj;g.‘llﬂa :
401.0 Hypertenzion, Malignant Charles Darwin 1141342010
401.0 Hypertensian, Malignant Susan Anthany 3/6/2003 Fas...

* Select objectives 9 or 10 as one of the 5 objectives from the menu set.
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Incentives and Payment Adjustments

The table below outlines the maximum incentive amounts that EPs can receive by year of adoption (of certified EHR
technology) and program (Medicare or Medicaid).

e e Pa e by Proagra
) : - ] ° ° ] - - - ° - i} i} - ° - © ° -
$18,000 | $21,250 ] ;,..-"

4 i P ] ,.-"'j ,.«"": ~
$12,000 | $8,500 | $18000 | $21250 [0/ Y/, ;fy//ﬁ’//ﬂd?}//ﬁ?//ﬁy//ﬁ //'"’///"'
$8,000 | $8,500 | $12,000 | $8,500 | $15.000 | $21,250 [ b st b b bl A A A A A
$4,000 | $8500 | $8000 | $8500 | $12000 | $8500 | $12,000 | $21,250 Vol et et ottt o ot ot A A o
$2,000 | $8,500 | $4,000 | $8500 | $8,000 | $8500 | $8,000 | $8,500 [ 821,250 [ Al
£ | $8,500 _s2000 | $8500 | $4000 | 88500 | $4000 | 88500 LA A 98500 [/ ] $21,250
C AL 8500 A 88500 [ A/ 58500 KA 8500 A/ 88,500
A, :;V// 41 $8,500 [/ $8,500 ::‘7//’ 7] $8,500 #7/’/ 1 38,500
LSS NS SRS S| S50 L] 8500 V) 8500
I R A o o s s A A A ]S850 L] $8500
/;m!;*%{{;yﬁ? ;W {;ﬁ’f,’;’f/ ,.-r‘fif/ ;’“’,{/;r;f;{/’;’/%ﬁ SB$8,5oo

* |f EP does not switch programs.
NOTE: Medicare EPs may not receive EHR incentive payments under both Medicare and Medicaid. The amount of the annual EHR incentive payment limit for each
payment year will be increased by 10 percent for EPs who predominantly furnish services in an area that is designated as a Health Professional Shortage Area.

N

N
\
\
\
N\
%

NN
\
\
\
N
NN
N

\
\

O
‘\.

Section 1848(a)(7) of the HITECH Act provides that beginning in 2015, EPs who do not demonstrate that they are
meaningful users of certified EHR technology will be subject to a payment adjustment equal to -1% of their Medicare PFS
allowed charges. This adjustment will increase to -2% for 2016, and -3% for 2017 and each subsequent year.

Registration and Attestation

In order to receive the incentive payments, EPs must first register for the either the Medicare or the Medicaid EHR
Incentive Program and meet the meaningful use criteria outlined in this document. Then, they must use the CMS
web-based system to successfully attest that they have met that criteria using certified EHR technology. During the
attestation process, EPs using My Vision Express will need to provide its CMS EHR Certification ID which is
30000001SVGLEAC. For additional information, please visit:

http://www.cms.gov/EHRIncentivePrograms/20 RegistrationandAttestation.asp

Timeline
JANUARY 2011 .
Registration Mgdlcare payment
for the EHR adjustments begin
Incentive APRIL 2011 . _ for EPs and eligible
Certified EHR Programs begins  Attestation for FEBRUARY 29, 2012 hospitals .that are Last year to
technology the Medicare Last day for EPs to not meaningful y Medicaid
available and EHR Incentive register and attest to users of EHR E‘;:E';E et' ical
listed on ONC Program hegins receive an Incentive technology b ”C‘E“ ve
website Payment for CY 2011 aymen
Fall 2010 Winter 2011 Spring 2011 Winter 2012 2014 2015 2016 2021
Last year to receive
MAY 2011 a Medicare EHR
i Incentive Payment
JANUARY 2011 Pt b Last year to initiate e
For Medicaid Payments begin yoar [0 I Last year to initiate
. participation in S
providers, States the Medicare EHR participation in

Medicaid EHR

may launch their :
Incentive Program

programs if they
so choose

Incentive Program
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http://www.cms.gov/EHRIncentivePrograms/20_RegistrationandAttestation.asp

Useful Links

EHR Incentive Programs page at the CMS website:
https://www.cms.gov/EHRIncentivePrograms/

EHR Incentive Programs Final Rule;
http://edocket.access.qpo.gov/2010/pdf/2010-17207.pdf

Incentive Programs Registration and Attestation Page:
https://ehrincentives.cms.gov/hitech/login.action

© 2011 Insight Software, LLC Page 15 of 15


https://www.cms.gov/EHRIncentivePrograms/
http://edocket.access.gpo.gov/2010/pdf/2010-17207.pdf
https://ehrincentives.cms.gov/hitech/login.action

